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Preface 

This User Guide has been implemented by Boot & Work, S.L. working 

under the name Industrial Shields.  

 

Purpose of the manual 

The information contained in this manual can be used as a reference to operate and get 
a better understanding of the technical data of the signal modules, power supply 
modules and interface modules. 

 

Intended Audience 

This User Guide is intended for the following audience: 

●​ Persons in charge of introducing automation devices. 

●​ Persons who design automation systems. 

●​ Persons who install or connect automation devices. 

●​ Persons who manage working automation installation. 

 

 

   Warnings: 

 

●​ It must be used a long micro USB-B type cable with the plastic part thin (contour of 

2mm). 

 

 

 

 

 

 

●​ Unused pins should not be connected. Ignoring the directive may damage the 

controller. 

●​ Improper use of this product may severely damage the controller. 

●​ Refer to the controller’s User Guide regarding wiring considerations. 

●​ Before using this product, it is the responsibility of the user to read the product’s User 

Guide and all accompanying documentation. 
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●​ Maintenance must be performed by qualified personnel familiarised with the 

construction, operation, and hazards involved with the control.  

●​ Maintenance should be performed with the control out of operation and disconnected 

from all sources of power.  

●​ Care should be taken when servicing electrostatic sensitive components. The 

manufacturer's recommendations for these components should be followed.  

●​ The ESP32 14 PLCs are Open Type Controllers. It is required that you install the ESP32 

14 PLC in a housing, cabinet, or electric control room. Entry to the housing, cabinet, or 

electric control room should be limited to authorised personnel. Failure to follow these 

installation requirements could result in severe personal injury and/or property 

damage. Always follow these requirements when ESP32 14 PLCs. 

●​ In case of installation or maintenance of the ESP32 14 please follow the instructions 

marked in the Installation and Maintenance section. 

●​ Do not disconnect equipment when a flammable or combustible atmosphere is 

present. Disconnection of equipment when a flammable or combustible atmosphere is 

present may cause a fire or explosion which could result in death, serious injury and/or 

property damage. 

 

 

   Avertissements: 

 

Il faut utiliser un long câble de type micro USB-B avec la partie plastique fine (contour 

de 2mm). 

 

 

 

 

 

 

Les broches non utilisées ne doivent pas être connectées. Ignorer la directive peut 

endommager le contrôleur. 

Une utilisation incorrecte de ce produit peut endommager gravement le contrôleur. 

Reportez-vous au Guide de l’utilisateur du contrôleur pour les considérations de 

câblage. 

Avant d’utiliser ce produit, il incombe à l’utilisateur de lire le Guide de l’utilisateur du 

produit et la documentation qui l’accompagne. 

La maintenance doit être effectuée par personnel qualifié familiarisé avec la 

fabrication, le fonctionnement et les dangers liés au contrôleur. 

La maintenance doit être effectuée avec l’équipement hors service et déconnectée de 

toutes les sources d'alimentation. 
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Faites attention lors de l'entretien des composants sensibles à l'électricité statique. Les 

recommandations du fabricant pour ces composants doivent être suivies. 

Les automates de la famille ESP32 14 sont des contrôleurs de type ouvert. Il est 

nécessaire d'installer l'automate ESP32 14 dans un boîtier, une armoire ou une salle de 

contrôle électrique. L'accès au boîtier, à l'armoire ou à la salle de commande 

électrique doit être limité au personnel autorisé. Le non-respect de ces exigences 

d'installation peut entraîner des blessures graves et/ou des dommages matériels 

importants. Respectez toujours ces exigences lors de l'installation des automates de la 

famille ESP32 14. 

En cas d'installation ou de maintenance du ESP32 14, veuillez suivre les instructions 

indiquées dans la section Installation et Maintenance. 

Ne débranchez pas l'équipement en présence d'une atmosphère inflammable ou 

combustible. La déconnexion de l'équipement en présence d'une atmosphère 

inflammable ou combustible peut provoquer un incendie ou une explosion pouvant 

entraîner la mort, des blessures graves et/ou des dommages matériels. 

 

Application Considerations and Warranty 

Read and Understand this Manual 

Please read and understand this manual before using the product. Please consult your 

comments or questions to Industrial Shields before using the product. 

 

Application Consideration                               
THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED. THEY SHOULD NOT 

BE RELIED UPON AS A SAFETY COMPONENT OR PROTECTIVE DEVICE FOR ENSURING SAFETY OF 

PERSONS, AS THEY ARE NOT RATED OR DESIGNED FOR SUCH PURPOSES.  

Please know and observe all prohibitions of use applicable to the products.  

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY WITHOUT ENSURING 

THAT THE SYSTEM AS A WHOLE HAS BEEN DESIGNED TO ADDRESS THE RISKS, NEVER USE THE 

INDUSTRIAL SHIELDS PRODUCTS.  

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE PROPERLY RATED AND 

INSTALLED FOR THE INTENDED USE WITHIN THE OVERALL EQUIPMENT OR SYSTEM.  

Industrial Shields shall not be responsible for conformity with any codes, regulations or 

standards that apply to the combination of products in the customer’s application or use of the 

product. 
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The following are some examples of applications for which particular attention must be  
given. This is not intended to be an exhaustive list of all possible uses of the products, 
nor is it intended to imply that the uses may be suitable for the products: 

●​ Systems, machines, and equipment that could present a risk to life or property. 
●​ Nuclear energy control systems, combustion systems, railroad systems, 

aviation systems, medical equipment, amusement machines, vehicles, safety 
equipment, and installation subject to separate industry or government 
regulations. 

●​ Outdoor use, uses involving potential chemical contamination or electrical 
interference, or conditions or uses not described in this document. 
 

At the customer’s request, INDUSTRIAL SHIELDS will provide applicable third-party 
certification documents identifying ratings and limitations of use that apply to the 
products. This information by itself is not sufficient for a complete determination of the 
suitability of the products in combination with the system, machine, end product, or 
other application or use. 

 

Intended use or of Industrial Shields products                                               
Consider the following: 

Industrial Shields products should only be used for the cases of application foreseen in the 

catalogue and the associated technical documentation. If third-party products and components 

are used, they must have been recommended or approved by Industrial Shields.  

The correct and safe operation of the products requires that your transport, storage, 

installation, assembly, operation and maintenance have been carried out in a correct manner. It 

must respect the permissible ambient conditions. You should also follow the indications and 

warnings that appear in the associated documentation. 

The product / system dealt with in this documentation should only be handled or manipulated 

by qualified personnel for the task entrusted and observing what is indicated in the 

documentation corresponding to it, particularly the safety instructions and warnings included 

in it. Due to their training and experience, qualified personnel are in a position to recognize 

risks resulting from the handling or manipulation of such products / systems and to avoid 

possible hazards. 

Disclaimers             
Weights and Dimensions 

Dimensions and weights are nominal and they are not used for manufacturing purposes, even 

when tolerances are shown. 
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Performance Data 

The performance data given in this manual is provided as a guide for the user in determining 

suitability and does not constitute a warranty. It may represent the result of INDUSTRIAL 

SHIELDS’s test conditions, and the users most correlate it to actual application requirements. 

Actual performance is subject to the INDUSTRIAL SHIELDS Warranty and Limitations of Liability. 

Change in Specifications 

Product specifications and accessories may be changed at any time based on improvements 

and other reasons. 

It is our practice to change model numbers when features are changed, or published ratings or 

when significant construction changes are made. However, some specifications of the products 

may be changed without any notice. When in doubt, special numbers may be assigned to fix or 

establish key specifications for your application on your request. Please consult with your 

INDUSTRIAL SHIELDS representative at any time to confirm actual specifications of purchased 

products. 

Errors and Omissions 

The information in this document has been carefully checked and is believed to be accurate; 

however, no responsibility is assumed for clerical, typographical, or proofreading errors, or 

omissions. 

Residual Risks 

The control and drive components of an Industrial Shields PLC are approved for industrial and 

commercial use in industrial line supplies. Their use in public line supplies requires a different 

configuration and/or additional measures. These components may only be operated in closed 

housings or in higher-level control cabinets with protective covers that are closed, and when all 

of the protective devices are used. These components may only be handled by qualified and 

trained technical personnel who are knowledgeable and observe all of the safety information 

and instructions on the components and in the associated technical user documentation. 

When carrying out a risk assessment of a machine in accordance with the EU Machinery 

Directive, the machine manufacturer must consider the following residual risks associated with 

the control and drive components of a PDS.  

1. Unintentional movements of driven machine components during commissioning, operation, 

maintenance, and repairs caused by, for example: − Hardware defects and/or software errors in 

the sensors, controllers, actuators, and connection technology − Response times of the 

controller and drive − Operating and/or ambient conditions not within the scope of the 

specification − Condensation / conductive contamination − Parameterization, programming, 

cabling, and installation errors − Use of radio devices / cellular phones in the immediate 

vicinity of the controller − External influences / damage.  
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2. Exceptional temperatures as well as emissions of noise, particles, or gas caused by, for 

example: − Component malfunctions − Software errors − Operating and/or ambient conditions 

not within the scope of the specification − External influences / damage. 

3. Hazardous shock voltages caused by, for example: − Component malfunctions − Influence of 

electrostatic charging − Induction of voltages in moving motors − Operating and/or ambient 

conditions not within the scope of the specification − Condensation / conductive 

contamination − External influences / damage  

4. Electrical, magnetic and electromagnetic fields generated in operation that can pose a risk to 

people with a pacemaker, implants or metal replacement joints, etc. if they are too close.  

5. Release of environmental pollutants or emissions because of improper operation of the 

system and/or failure to dispose of components safely and correctly. 

Warranty and Limitations of Liability 
Warranty 

Industrial Shields’s exclusive warranty is that the products are free from defects in materials 

and workmanship for a period of one year (or other period if specified) from date of sale by 

Industrial Shields. 

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY, EXPRESSED OR IMPLIED, 

REGARDING MERCHANTABILITY, NON-INFRINGEMENT, OR FITNESS FOR PARTICULAR PURPOSE 

OF THE PRODUCTS. ANY BUYER OR USER ACKNOWLEDGES THAT THE BUYER OR USER ALONE 

HAS DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET THE REQUIREMENTS OF THEIR 

INTENDED USE. INDUSTRIAL SHIELDS DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR 

IMPLIED 

Limitations of Liability 

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT, OR CONSEQUENTIAL 

DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN ANY WAY CONNECTED WITH THE 

PRODUCTS, WHETHER SUCH CLAIM IS BASED ON CONTRACT, WARRANTY, NEGLIGENCE, OR 

STRICT LIABILITY. 

IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONSIBLE FOR WARRANTY, REPAIR OR OTHER 

CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL SHIELDS’S ANALYSIS CONFIRMS THAT 

THE PRODUCTS WERE PROPERLY HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT 

SUBJECT TO CONTAMINATION, ABUSE, MISUSE, OR INAPPROPRIATE MODIFICATION OR REPAIR. 
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1.​ ESP32 14 Module: General Features 

COMPACT ESP32 PLC 14 MODULE PLC  

Input Voltage 
 

12 to 24Vdc 
 

Fuse protection (2.5A) 
Polarity protection 

 

Input rated voltage 
 

24Vdc 
 

 

Rated Power 30W  

I Max.  1,5A  

Size 100x45x115  

Clock Speed External: 240 MHz   Internal: 8 MHz  

External Flash Memory 4MB  

SRAM 4 MB  

PSRAM 2 MB  

Communications USB - RS485 - I2C - ETH - WiFi - BLE MAX487CSA - W5500 

An/Dig Input 12 bit *(see 
Section 9.2) 

0 - 10Vdc 
OR 

4-20mA 
OR 

5– 24Vdc  
 
 

 
Input Impedance: 52K9 (all modes) 

Freq: 1.3KHz (all modes) 
 

0 to 10Vdc 
Rated Voltage: 10Vdc 

I min: 0.1mA 
I max: 0.2mA 

OR 
4 to 20mA 
I min: 0mA 

I max: 20mA 
OR 

5 to 24Vdc 
I min: 0.1mA 

I max: 14.45mA 
         Rated Voltage: 24Vdc 
 

  

*Check Section 10 for digital 
inputs threshold detection 

Digital Input 
3,3 – 24Vdc 

 

 
3.3 to 24Vdc 
Freq: 1.5KHz 

Input Impedance: 4K2 
Separated PCB ground 

I min: 0.5mA 
Opto-isolation 

         Rated Voltage: 24 Vdc 
 

  

 

Relay Output 

30Vdc / 250Vac  
Galvanic Isolation 

Diode protected for Relay 
 
 

Imax: 3A (30Vdc) 
Imax: 5A (250Vac) 

Digital Isolated Output 

5 to 24Vdc 
I max: 70 mA 

Galvanic Isolation 
Diode Protected for Relay 

Rated Voltage: 24Vdc 
 
 

Imax 24Vdc: 410 mA 

Expandability USB - RS485 - I2C - ETH - WiFi - BLE  

Reference IS. 013000000001  
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1.1​ Power consumption of the 14 IOs PLC 

Current resting  
(mA) 

Power resting 
(W) 

Current active (mA) Power active  
(W) 

42 1,008 81 1,944 

 

The power consumption is measured at 24Vdc.  

The current resting column denotes the minimum current drawn by the PLC when all outputs 

are at a LOW level, representing the PLC's baseline power consumption. 

In contrast, the current active column reflects the current drawn by the PLC when all outputs 

are at a HIGH level, and there are no connections to any of the outputs. While this value is not 

the absolute maximum the ESP32 based PLC can draw, it serves as a reference point for 

expected current values. 

It's important to note that the practical maximum current may vary depending on the type of 

actuators connected to the outputs and the number of I/Os used. The actual consumption can 

be influenced by the specific configuration and load connected to the PLC's outputs." 
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2.​ Technical Specifications 

2.1​ General Specifications 

Item ESP32 PLC 14 

Power supply 
voltage 

DC power supply    12 to 24 Vdc   

Operating 
voltage range 

DC power supply 11.4 to 25.4 Vdc  

Power 
consumption 

DC power supply 30 W max. 

External 
power supply 

Power supply 
voltage 

24 Vdc  

Power supply 
output capacity 

300 mA 

Dielectric strength 
1500 Vac at 50/60 Hz for one minute with a leakage 
current of 10 mA max. 

Shock resistance 
50 m/s² in the X, Y and Z direction 3 times each, 
complying with the IEC-60068-2-27:2008 standard. 

Ambient temperature (operating) -20 º to 70 ºC 

Ambient humidity (operating) 10 % to 90 % (no condensation) 

Ambient environment (operating) With no corrosive gas 

Ambient temperature (storage) -20 º to 70 ºC 

Power supply holding time 2 ms min. 

Weight 350 g max. 
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2.2​ Performance Specification 

Board ESP32 DevKit C (3.3V) 

Control method Stored program method 

I/O control method 
Combination of the cyclic scan and immediate refresh processing 
methods. 

Programming language 
Arduino IDE. Based on wiring (Wiring is an Open Source electronics 
platform composed of a programming language. “similar to the C”. 
http://arduino.cc/en/Tutorial/HomePage 

Microcontroller ESP32 

External Flash Memory 4MB 

Program capacity (SRAM) 4MB 

PSRAM 2MB 

Clock Speed 8MHz 

 

2.3​ 14 IOs Pinout 

  IOs Table 

Model Reference 
Analog Input (4-20 

mA / 0-10V) * 

Digital Isolated 

Input 

Digital Isolated 

Output 
Relay Output 

14 IOs 013000000001 2 7 4 1 

 

*  The analog inputs can also be used as digital inputs. 
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2.4​ Symbology 

Table that includes all the symbology that is used in the serigraph of the ESP32 PLC 14 Module: 

Symbol 
Standard No. / 
Standard Title 

Standard Reference 
No. / Symbol Title 

Symbol Meaning 

 

IEC 60417 / 
Graphical symbols 

for use on 
equipment 

5031 / Direct 
Current 

Indicates that the equipment is 
suitable for direct current only; to 

identify relevant terminals 

 

IEC 60417 / 
Graphical symbols 

for use on 
equipment 

5032 / Alternating 
Current 

Indicates that the equipment is 
suitable for alternating current 

only; to identify relevant 
terminals 

 IEC 60417 / 
Graphical symbols 

for use on 
equipment 

5130 / Pulse General 
To identify the control by which a 

pulse is started. 

​
​
​
​
 

IEC 60417 / 
Graphical symbols 

for use on 
equipment 

5017 / Earth, 
Ground 

To identify an earth (ground) 
terminal in cases where neither 

the symbol 5018 nor 5019 is 
explicitly required. 

 IEC 60417 / 
Graphical symbols 

for use on 
equipment 

5115 / SIgnal lamp 
To identify the switch by means 

of which the signal lamp(s) is 
(are) switched on or off. 

​
​
​
 

2004/108/EC / 
Electromagnetic 

Compatibility 
CE Marking 

CE marking indicates that a 
product complies with applicable 

European Union regulations 

 
 ISO 7000/ Graphical 

symbols for use on 
equipment 

0434B / 
Warning symbol 

Indicates a potentially hazardous 
situation which, if not avoided, 
could result in death or serious 

injury 

​
​
​
 

ISO 7000/ Graphical 
symbols for use on 

equipment 

5036 / Dangerous 
Voltage 

To indicate hazards arising from 
dangerous voltages 
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3.​ Precautions 

Read this manual before attempting to use the ESP32 14 PLC and follow its descriptions for 
reference during operation. 

3.1​ Intended Audience 

This manual is intended for technicians, which must have knowledge on electrical systems. 

3.2​ General Precautions 

The user must operate ESP32 14 Module according to the performance specifications 

described in this manual. 

Before using ESP32 14 PLC under different conditions from what has been specified in this 

manual or integrating ESP32 14 Module to nuclear control systems, railroad systems, aviation 

systems, vehicles, combustion systems, medical equipment, amusement machines, safety 

equipment and other systems, machines, and equipment that may have a serious influence on 

lives and property if used improperly, consult your INDUSTRIAL SHIELDS representative. Ensure 

that the rating and performance characteristics of ESP32 14 Module are sufficient for the 

systems, machines, and equipment, and be sure to provide the systems, machines, and 

equipment double safety mechanisms. This manual provides information for programming and 

operating the ESP32 14 Module. 

3.3​ Isolation Precautions 

Description: 

This equipment does not include galvanic isolation between the grounds of the different 

systems. This means that if an external device or sensor that shares the same ground reference 

(GND) with the system is connected, any potential difference between these grounds could 

damage the connected components. To avoid issues with interference, ground loops, or 

damage to external equipment, ensure that all connected devices share the same ground 

reference or use systems with appropriate isolation. 

Recommendations: 

●​ Connection Review: Verify that all ground connections are properly made and that 

there are no significant potential differences between them. 

●​ Use of Isolation: Consider using galvanic isolators or isolation transformers if it is 

necessary to connect equipment with different ground references. 

 ​
​
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4.​ Software interface  

Industrial Shields PLC are programmed using Arduino IDE, which is a software based on the C 

language. They can also be programmed directly using C but it is much easier working with 

Arduino IDE as it provides lots of libraries that help in the programming.   

Furthermore, Industrial Shields provide boards for programming the PLCs much easier. 

Basically, it is not needed to define the pins and if those pins are inputs or outputs. Everything 

is set up automatically if using the boards. 

In order to install Industrial Shields boards, these are the steps that must be followed. 

Requirements: 

Arduino IDE 1.8.19 or above (better to always have the latest version). 

Steps: 

1.​ Open Arduino IDE and go to: “File -> Preferences” located in the top left corner. 

 

 

2.​ In Additional Boards URLs write the following: 

http://apps.industrialshields.com/main/arduino/boards/package_industrialshields_index.json 

If you already have an URL inserted, input an “,” between both URLs. 

 

3.​ Press OK to save the changes. 

 

17 
 

http://apps.industrialshields.com/main/arduino/boards/package_industrialshields_index.json


Rev. 7: 09-01-2025 

4.​ Go to: Tools -> Board: … -> Boards Manager  

 

5.​ Search for industrialshields-esp32. 

 

6.​ Click install industrialshields-esp32 (selecting the latest version). 

Following this steps you will be able to use now the Industrial Shields Boards: 
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Once it is selected the 14 IOs PLC in Industrial Shields ESP32, an extra option will appear on 

“Tools”: 

 

There, it is possible to select the mode used for the ESP32 PLC 14. In this case 14 IOs PLC (4-20 

mA). 

Also, there are some examples of programming in File -> Examples -> ESP32 14 PLC Family. 

Furthermore, there are some extra libraries that can be found in Industrial Shields GitHub. 

https://github.com/Industrial-Shields/ 
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5.​ How to connect 14 IOs to PC 

-​ Connect USB port from PLC to PC. 

NOTE:  
ESP32 14 PLC uses a long micro USB 
cable.  
 

 
-​ Open Arduino IDE interface: 
-​ Select the correct board. 
-​ Select the correct port. 
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6.​ How to connect PLC to power supply 

-​ ESP32 14 PLCs are 12-24Vdc supplied. IMPORTANT: The polarity IS NOT REVERSAL!  

-​ Make sure that the live and GND connector of the power supply match the PLC. 

-​ Make sure that the power supply mains output is not higher than 24Vdc. 

 

-​ Suggested power suppliers  

 

The standard, Part 1 of IEC 61010, sets the general safety requirements for the following types 

of electrical devices and their accessories, regardless of where use of the device is intended.  

The equipment must be powered from an external power source in accordance with IEC 

61010-1, whose output is MBTS and is limited in power according to section 9.4 of IEC 61010-1. 

WARNING: Once the equipment is installed inside an electrical cabinet, the MTBS cables of the 

equipment must be separated from the dangerous voltage cables. 
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7.​ Block diagram 

 

NOTE: You have to take into account the internal communications when using the external 

ones; initialise and/or use the according peripheral for each functionality: 

●​ SPI: external SPI, Ethernet, Expansion Board (depending on the type) 

●​ I2C: external I2C, IOs, Expansion Board (depending on the type) 

In the case of the SPI you have to use the CS to select the Ethernet (CS0) or the external SPI 

(CS1). In the case of the I2C you only have to take into account that each device has its own 

unique address and the order of initialisation in the code.  

 

 

                                  

22 
 



Rev. 7: 09-01-2025 

8.​ ESP32 14 serigraphy 

 

14 IOs 
Connector 

ESP32 
Pin 

Function 

A+ 
B- 

SCL 
SDA 
GND 
5V 

GND 
GND 

AI0.1/I0.8 
AI0.0/I0.7 

I0.6 
I0.5 
I0.4 
I0.3 
I0.2 
I0.1 
I0.0 
GND 

A+ 
B- 

SCL 
SDA 
GND 
5V 

GND 
GND 

G33/G35 
G32/G34 

GPA5 
GPA6 
GPA4 
GPB5 
GPB4 
GPB2 
GPB3 
GND 

RS485 
RS485 

I2C 
I2C 

GND 
- 

GND 
GND 

Analog/Digital Input 
Analog/Digital Input 

Digital Input 
Digital Input 
Digital Input 
Digital Input 
Digital Input 
Digital Input 
Digital Input 

GND 
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14 IOs 
Connector 

ESP32 
Pin 

Function 

REL-B 
REL-A 
GND 
GND 
Q0.3 
Q0.2 
Q0.1 
Q0.0 
Vdc 
GND 

CON2 
CON1 
GND 
GND 
G27 
G26 
G25 
G12 

- 
GND 

Relay 
Relay 
GND 
GND 

Digital Output 
Digital Output 
Digital Output 
Digital Output 
Power Supply 

GND 
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NOTE: In case you need to activate the reset button, it can be found by opening the top cover 

and accessing the white reset button of the ESP32  board integrated inside the enclosure. 

NOTE: The LEDs positioned at the top of the PLC, which go from led 0 to 8 refer to both inputs 

and outputs. 

For example, if you are using input I0.4, LED 4 on the top cover of the PLC will indicate the 

signal status of this input. 

If output Q0.0 is being used, LED 0 on the upper cover of the PLC will indicate the status of the 

signal of this output. 

An input and an output with the same nomenclature can never work at the same time.  
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9.​ Pinout Response 

9.1​ Digital Inputs 

 Average (μs) Max time (μs) 

Digital input 455 660 

 

9.2​ Analog Inputs 

As a Average (μs) Max time (μs) 

Digital input 1 23 

Analog input (4-20mA) 94 524 

Analog input (0-10V) 90 517 

 

9.3​ Digital Outputs 

Output frequency Period Delay Duty cycle 

19,53 kHz 51 μs 25 μs 82,23 % 

333,3 Hz 3 ms 1,5 ms 50 % 

 

Rise time Fall time 

15,40 ns 5,36 μs 
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10.​ Software set up 

Whether they are digital, analog or relay, the inputs and outputs must be configured in the set 

up part of the code, like it is usually done in common Arduino boards. The function that must 

be used is pinMode(), like it is explained on the official Arduino website:  

https://www.arduino.cc/reference/en/language/functions/digital-io/pinmode/ 

Check sections 4 and 5 to configure the software interface and to connect the ESP32 PLC 14 to 

the PC. 

Before programming the ESP32 PLC 14 is required to connect it to the power supply. Check 

section 6 for more information. 

10.1​ Digital Input​  

To configure a digital input, it can be done this way:  

pinMode(I0_0, INPUT); 

The available digital input pins are defined between I0_0 and I0_6. Here is an implementation 

example: 

 

*Pins I0_7 and I0_8 can also be used as digital.  
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10.2​ Analog Input 

To configure an analog input, it can be done this way:  

pinMode(I0_7, INPUT); 

 

The available analog input pins are defined as I0_7 and I0_8. Here is an implementation 

example: 

 

*Note: Consider that depending on your selection when acquiring the PLC, the model you use 

will have either two analog inputs of 0-10Vdc or 4-20mA, but both cannot coexist in the same 

PLC, nor be modified by software. 
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*Note: The analog inputs have a resolution of 11.507 bits counting from 0 to 10Vdc. The first 

0.5V (0-0.5Vdc -> 0 - 222) range is not detected. The remaining range is offset by approximately 

-171, starting at V< 0.5 -> 0. 

This issue stemming from the ESP32 GPIOs is corrected automatically by the analogRead() 

function on ESP32 PLC 14 (you must have our Boards installed and select the right device and 

model when compiling and uploading the code). This is internally done by multiplying 

(value+171)*1.295 when the value is non-zero. This corrects the bit resolution and offset, but 

the range between 0-0.5V still can not be detected since there is no data to work with. 
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10.3​ Digital Output 

To configure a digital output, it can be done this way:  

pinMode(Q0_0, OUTPUT); 

 

The available digital output pins are defined between Q0_0 and Q0_3. Here is an 

implementation example: 

 

Each has an internal pin called SX_24v, where X is the number of the output. By setting the 

value of this pin, we can select the output mode: 

●​ Set to LOW to select 5V mode. 

●​ Set to HIGH to select Vdc mode. 

Here is an implementation example: 
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10.4​ Relay Output 

To configure the relay, it can be done this way:  

pinMode(R0_0, OUTPUT); 

 

The available relay output is defined as R0_0. Here is an implementation example: 

 

 

11.​ Digital inputs threshold detection 

The ESP32 PLC 14 inputs have a minimum voltage threshold to reliably detect the signal when 

used as digital input. The threshold value is different depending on the input type: 
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Input type Threshold voltage (V) 

Digital input 4.1 

Analog input (0-10V mode) 6.5 
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12.​ Instructions: How to upload a program 

Uploading a program to your ESP32 PLC is usually straightforward. However, if you encounter 

issues such as the upload process getting stuck, receiving an error, or being unable to use the 

serial monitor, follow these steps to resolve the problem. 

Step 1: Verify the Switch Position Next to the microUSB Port 

●​ Switch on the Left (Programming Mode): This is the default mode that allows 

uploading code and using the serial monitor. 

●​ Switch on the Right (Boot Mode): This mode is typically used for boot-related 

operations and may prevent normal programming or serial monitoring. 

If the switch next to the microUSB port is on the right (Boot Mode), move it to the left 

(Programming Mode) and attempt to upload the program again. 

Step 2: Troubleshooting Further Issues 

If the switch was already in the correct position (left) and you are still experiencing problems, 

follow these steps: 

1.​ Connect the ESP32 PLC: Ensure that the microUSB cable is properly connected to both 

the ESP32's microUSB port and your computer. 

2.​ Switch to Boot Mode: Move the switch next to the microUSB port to the right side 

(Boot Mode). 

3.​ Upload the Code: Proceed to upload your program to the ESP32 PLC. 

4.​ Switch Back to Programming Mode: After the code has been successfully uploaded, 

move the switch back to the left side (Programming Mode). 

5.​ Reset the ESP32 PLC: Press the RESET button located on the top of the ESP32 PLC 

board. 

This should resolve most issues with uploading programs to your ESP32 and allow you to use 

the serial monitor as intended. 
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13.​ I/Os Communications  

13.1​ RS485 

The RS-485 is a half-duplex serial communication. The ESP32 14 PLC uses the MAX841CSA for 

the RS-485 communication. In the following image you can see the internal schematic of the 

PLC of the connection between microcontroller pins, the RS-485 chip and its outputs. 

  

Using the boards of Industrial Shields, there is a library that simplifies the RS-485 

implementation. 

The RS-485 communication interface of the PLC supports both master and slave functionalities 

for the Modbus RTU protocol. The integration can be achieved by using our Modbus library. 

13.2​ I2C 

The I2C protocol is meant to work in a pull-up configuration. A pull-up configuration means 

that when the pin is at rest (nothing connected to it) it always reads a HIGH value. In this case it 

reads 5V when nothing is connected. The pull-up configuration is established by default in 

these pins. 

The I2C communication can be achieved by using the Wire library from Arduino. Additionally, 

the Arduino IDE offers some examples under “File > Examples > Wire” such as “WireScan.ino” 

to scan the available I2C addresses. 
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13.3​ Ethernet 

ESP32 14 Ethernet port controller is based on w5500 IC, which is the IC compatible with 

Arduino Ethernet2 Shield libraries. All Ethernet shield Arduino libraries are compatible with the 

ESP32 14. In the ESP32 14 PLC, W5500 IC communicates to the microcontroller board via SPI 

bus. 

The Ethernet interface of the PLC supports both master and slave functionalities for the 

Modbus TCP protocol. The integration can be achieved by using our Modbus library. 

13.4​ WiFi & BLE 

The WiFi and Bluetooth integrated module consists of a single 2.4 GHz Wi-Fi and Bluetooth 
combo chip designed with the TSMC ultra-low-power 40 nm technology. It is designed to 
achieve the best power and RF performance, showing robustness, versatility and reliability in a 
wide variety of applications and power scenarios. Some applications are Generic Low-power 
IoT Sensor Hub, Generic Low-power IoT Data Loggers and Mesh Network. 
It is designed for Internet-of-Things (IoT) applications.  

13.4.1​ General Specifications 

Wi-Fi 
●​ 802.11 b/g/n  
●​ 802.11 n (2.4 GHz), up to 150 Mbps 

Bluetooth 

●​ Bluetooth 4.2 BR/EDR BLE dual mode controller 
●​ +12 dBm transmitting power 
●​ NZIF receiver with -97 dBm BLE sensitivity 
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14.​ Additional features: Expansion Modules 

14.1​ LoRa 

The LoRa expansion board can use the RN2483 or RN2903 microchip depending on the 

frequency needed, which have the following features: 

●​ Model: RN2483 (for Europe/Asia), RN2903 (for North America/Australia) 

●​ Type: LoRa 

●​ Key Features: On-board LoRaWAN protocol stack, ASCII command interface over UART, 

Castellated SMT pads for easy and reliable PCB mounting, Environmentally friendly, 

RoHS compliant, Device Firmware Upgrade (DFU) over UART, etc. 

●​ Applications: Automated Meter Reading, Home and Building Automation, Wireless 

Alarm and Security System, Industrial Monitoring and Control, Machine to Machine 

(M2M), Internet of Things (IoT), etc. 

 

14.2​ CAN 

The CAN expansion board uses the MCP2515 microchip, which has the following features: 

●​ Model: MCP2515 

●​ Type: CAN V2.0B 

●​ Key Features: Speed of 1Mb/s, receive buffers, masks and filters, data byte filtering on 

the first two data bytes, three transmit buffers with prioritization and abort features, 

high speed SPI interface (10MHz), etc. 

●​ Applications: Communication with all kinds of CAN devices and the protocols that can 

be applied to this communication method. 

14.3​ LTE/NBIoT 

The LTE/NBIoT expansion board uses the SARA-R412M module, which has the following 

features: 

●​ Model: SARA-R412M 

●​ Type:  LTE-M / NB-IoT / EGPRS 

●​ Key Features: LTE Cat M1/NB1, and EGPRS module with multi-regional coverage, low 

power consumption, high precision, ideal for mission-critical IoT solutions, ensures 

data integrity, over-the-air firmware updates, and more. 

●​ Applications: Remote monitoring automation, asset tracking, surveillance and security, 

home automation systems, point of sales terminals etc. 
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15.​ Typical Connections 
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16.​ Connector details 

For I/O and power supply there is a 15EDGK-3.81-02P-14-00A(H) connector from DEGSON 

ELECTRONICS. 15EDGK-3.81-02P-14-00A(H) 

For communication pinout there is a FK-MC 0,5/10-ST-2,5 - 1881406 connector from Phoenix 

contact. FK-MC 0,5/10-ST-2,5 

Connection details: 

Article reference 15EDGK-3.81-02P-14-00A(H) 

Pitch 3,81mm 

Depth 15,5mm 

Width 11,2mm 

Length 8,41mm 

Current Rating 
 

Voltage Rating 

8A 
 

125V 

 

Article reference FK-MC 0,5/10-ST-2,5 

Rigid conduit section min. 0,14 mm² 

Rigid conduit section max. 0,5 mm² 

Flexible conduit section min. 0,14 mm² 

Flexible conduit section max. 0,5 mm² 

Conduit section AWG/kcmil min. 26 

Conduit section AWG/kcmil max. 20 

 

​
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17.​ ESP32 14 Dimensions 

 

45mm width 

 

 

 

-​ DIN rail mounting: 

 

 

​  
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18.​Installation and Maintenance 

 
Notes for installation: 
 

-​ The installation position should be free from the following: dust or oil smoke, 
conductive dust, corrosive or flammable gas, high temperature, condensation, and 
rain.  

-​ Besides, vibration and impact also affect the PLC normal operation and shorten its 
lifespan; electric shock, fire or misact also damages the product. During drilling or 
wiring, prevent the metal particles or wire segments from falling into the PLC casing, 
which may cause fire, fault or misact.  

-​ After the PLC installation, clean the ventilation duct to prevent blocking, which may 
cause bad ventilation, or even fire, faults or misact.  

-​ Do not online connect, plug or unplug cables, which are apt to cause electric shock or 
damage the circuit. Installation and wire connection must be firm and reliable. Poor 
connection could cause a misact.  

-​ Use shielded twisted pairs for the I/O of high frequency signal and analog signal to 
improve system IMS. 

 
The installation environment should be free from dust, oil smoke, conductive particles, 
corrosive or flammable gases, high temperature, condensation, and rain.  

 
Besides, vibration and impact also affect the PLC normal operation and shorten its lifespan. It is 
recommended to install the PLC, together with the matching switches and contactors, in a 
dedicated electric cabinet and keep the cabinet ventilated. If the location has high ambient 
temperature or heat generating equipment nearby, install forced convection devices on top or 
sides of the cabinet to avoid over-temperature. During drilling or wiring, prevent the metal 
particles or wire segments from falling into the PLC casing, which may cause fire, fault or 
misact. After the PLC installation, clean the ventilation duct to prevent blocking, which may 
cause bad ventilation, or even fire, faults or misact. 

 
The only way to disconnect the equipment from the electrical network is by removing the 
connectors that feed the equipment. Once installed in the electrical cabinet it is very important 
to ensure the power connectors for proper operation. 

 
 

Separate the ESP32 14 MODULE from heat, high voltage and electrical noise: 
 
 

Always separate the devices that generate high voltage and high electrical noise from the 
ESP32 14 Module. When configuring the layout of the ESP32 14 Module inside your panel, 
consider the heat-generating devices and locate the electronic-type devices in the cooler areas 
of your cabinet. Reducing the exposure to a high-temperature environment will extend the 
operating life of any electronic device. Also consider the routing of the wiring for the devices in 
the electric cabinet. Avoid placing low-voltage signal wires and communications cables in the 
same tray with AC power wiring and high energy, rapidly switched DC wiring.  
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Provide adequate clearance for cooling and wiring ESP32 14 Module. Is designed for natural 
convection cooling. For proper cooling, you must provide a clearance of at least 25 cm above 
and below the devices. Also, allow at least 25 cm of depth between the front of the modules 
and the inside of the enclosure. 

 
Notes for maintenance: 
 
A well-planned and executed maintenance program is essential to the satisfactory operation of 
solid-state electrical equipment. The kind and frequency of the maintenance operation will 
vary with the kind and complexity of the equipment as well as with the nature of the operating 
conditions. Maintenance recommendations of the manufacturer or appropriate product 
standards should be followed. 
 
The following factors should be considered when formulating a maintenance program:  
 

-​ Maintenance must be performed by qualified personnel familiar with the construction, 
operation, and hazards involved with the control.  

-​ Maintenance should be performed with the control out of operation and disconnected 
from all sources of power.  

-​ Care should be taken when servicing electrostatic sensitive components. The 
manufacturer's recommendations for these components should be followed.  

-​ Ventilation passages should be kept open. If the equipment depends upon auxiliary 
cooling, e.g., air, water, or oil, periodic inspection (with filter replacement when 
necessary) should be made of these systems.  

-​ The means employed for grounding or insulating the equipment from ground should 
be checked to assure its integrity. 

-​ Accumulations of dust and dirt on all parts, including on semiconductor heat sinks, 
should be removed according to the manufacturer's instructions, if provided; 
otherwise, the manufacturer should be consulted. Care must be taken to avoid 
damaging any delicate components and to avoid displacing dust, dirt, or debris in a way 
that permits it to enter or settle into parts of the control equipment. 

-​ Enclosures should be inspected for evidence of deterioration. Accumulated dust and 
dirt should be removed from the top of the enclosures before opening doors or 
removing covers.  

-​ Certain hazardous materials removed as part of maintenance or repair procedure (e.g., 
polychlorinated biphenyls (PCBs) found in some liquid filled capacitors) must be 
disposed of as described in Federal regulations. 

 
Safety rules for maintenance personnel 
 
Consider the following steps to follow. A false manoeuvre could be the cause of an accident or 
material damage. 
 
Do not disassemble or modify the modules. This could lead to breakdowns or malfunctions and 
could lead to injuries or fire. 
 

-​ All types of radio communication devices, including mobile phones and personal 
handy-phone systems (PHS), must be kept more than 25cm away from the PLC in all 
directions. Failure to observe this precaution exposes malfunctions caused by excess 
temperature. 
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-​ Disconnect the external power supply of the system (on all phases) before connecting 
or disconnecting a module. Failure to observe this precaution may cause faults or 
malfunctions of the module. 

-​ Tighten the screws of the terminal ports and the screws of the connectors within the 
prescribed tightening torque. Insufficient tightening can lead to loose parts or wires 
and cause malfunctions. Excessive tightening can damage the screws and / or the 
module, with the risk of falling, short circuits and malfunctions. 

-​ Before handling a module, dispose of the electrostatic charge accumulated by the 
human body by touching a suitable conductive object. Failure to observe this 
precaution may cause faults or malfunctions of the module. 

 
Repair note: 
 
If the equipment is suitable to be repaired, it must be verified that the equipment remains in a 
safe state after repair. 
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19.​ Revision Table 

Revision Number Date Changes 

0 11/12/23 First Implementation  

1 13/03/24 Second Implementation 

2 03/04/24 Third Implementation 

3 18/07/24 Fourth Implementation 

4 04/09/24 Added “How to upload a program” section 

5 26/09/2024 Added section 3.3 (“Isolation Precautions”) 

6 01/10/2024 Change on Section 10.3 

7 09/01/2025 Corrections on section 2.1 (“General Specifications”) 
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About Industrial Shields: 
 
Direction: Camí del Grau, 25 

Zip/Postal Code: 08272  

City: Sant Fruitós de Bages (Barcelona)  

Country: Spain 

Telephone: (+34) 938 760 191 / (+34) 635 693 611 

Mail: support@industrialshields.com  
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Preface 

This User Guide has been implemented by Boot & Work, S.L. working 

under the name Industrial Shields.  

 

Purpose of the manual 

The information contained in this manual can be used as a reference to operating, to 
functions, and to the technical data of the signal modules, power supply modules and 
interface modules.  

 

Intended Audience 

This User Guide is intended for the following audience: 

●​ Persons in charge of introducing automation devices. 

●​ Persons who design automation systems. 

●​ Persons who install or connect automation devices. 

●​ Persons who manage working automation installation. 

 

 

   Warnings: 

 

●​ Unused pins should not be connected. Ignoring the directive may damage the 

controller. 

●​ Improper use of this product may severely damage the controller. 

●​ Refer to the controller’s User Guide regarding wiring considerations. 

●​ Before using this product, it is the responsibility of the user to read the product’s User 

Guide and all accompanying documentation. 

●​ Maintenance must be performed by qualified personnel familiarised with the 

construction, operation, and hazards involved with the control.  

●​  Maintenance should be performed with the control out of operation and disconnected 

from all sources of power.  

●​ Care should be taken when servicing electrostatic sensitive components. The 

manufacturer's recommendations for these components should be followed.  

●​ The ESP32 ETHERNET & WIFI & BLUETOOTH PLCFamily PLCs are Open Type Controllers. 

It is required that you install the ESP32 ETHERNET & WIFI & BLUETOOTH PLCPLC in a 

housing, cabinet, or electric control room. Entry to the housing, cabinet, or electric 
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control room should be limited to authorized personnel. Failure to follow these 

installation requirements could result in severe personal injury and/or property 

damage. Always follow these requirements when installing ESP32 ETHERNET & WIFI & 

BLUETOOTH PLC family PLCs. 

●​ In case of installation or maintenance of the ESP32 ETHERNET & WIFI & BLUETOOTH 

PLC please follow the instructions marked in the Installation and Maintenance section. 

●​ Do not disconnect equipment when a flammable or combustible atmosphere is 

present. Disconnection of equipment when a flammable or combustible atmosphere is 

present may cause a fire or explosion which could result in death, serious injury and/or 

property damage. 

 

   Avertissements: 

 

●​ Les broches non utilisées ne doivent pas être connectées. Ignorer la directive peut 

endommager le contrôleur. 

●​ Une utilisation incorrecte de ce produit peut endommager gravement le contrôleur. 

●​ Reportez-vous au Guide de l’utilisateur du contrôleur pour les considérations de 

câblage. 

●​ Avant d’utiliser ce produit, il incombe à l’utilisateur de lire le Guide de l’utilisateur du 

produit et la documentation qui l’accompagne. 

●​ La maintenance doit être effectuée par personnel qualifié familiarisé avec la 

fabrication, le fonctionnement et les dangers liés au contrôleur. 

●​ La maintenance doit être effectuée avec l’équipement hors service et déconnectée de 

toutes les sources d'alimentation. 

●​ Faites attention lors de l'entretien des composants sensibles à l'électricité statique. Les 

recommandations du fabricant pour ces composants doivent être suivies. 

●​ Les automates de la famille ESP32 ETHERNET & WIFI & BLUETOOTH PLC sont des 

contrôleurs de type ouvert. Il est nécessaire d'installer l'automate ESP32 ETHERNET & 

WIFI & BLUETOOTH PLC dans un boîtier, une armoire ou une salle de contrôle 

électrique. L'accès au boîtier, à l'armoire ou à la salle de commande électrique doit 

être limité au personnel autorisé. Le non-respect de ces exigences d'installation peut 

entraîner des blessures graves et/ou des dommages matériels importants. Respectez 

toujours ces exigences lors de l'installation des automates de la famille ESP32 

ETHERNET & WIFI & BLUETOOTH. 

●​ En cas d'installation ou de maintenance du ESP32 ETHERNET & WIFI & BLUETOOTH 

PLC, veuillez suivre les instructions indiquées dans la section Installation et 

Maintenance. 

●​ Ne débranchez pas l'équipement en présence d'une atmosphère inflammable ou 

combustible. La déconnexion de l'équipement en présence d'une atmosphère 

inflammable ou combustible peut provoquer un incendie ou une explosion pouvant 

entraîner la mort, des blessures graves et/ou des dommages matériels. 
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Application Considerations and Warranty 

  Read and understand this manual           
 

Please read and understand this manual before using the product. Please consult your 

comments or questions to Industrial Shields before using the product. 

 

  Application Consideration            

THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED. THEY SHOULD NOT 

BE RELIED UPON AS A SAFETY COMPONENT OR PROTECTIVE DEVICE FOR ENSURING SAFETY OF 

PERSONS, AS THEY ARE NOT RATED OR DESIGNED FOR SUCH PURPOSES.  

Please know and observe all prohibitions of use applicable to the products.  

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY WITHOUT ENSURING 

THAT THE SYSTEM AS A WHOLE HAS BEEN DESIGNED TO ADDRESS THE RISKS, NEVER USE THE 

INDUSTRIAL SHIELDS PRODUCTS.  

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE PROPERLY RATED AND 

INSTALLED FOR THE INTENDED USE WITHIN THE OVERALL EQUIPMENT OR SYSTEM.  

Industrial Shields shall not be responsible for conformity with any codes, regulations or 

standards that apply to the combination of products in the customer’s application or use of the 

product. 

The following are some examples of applications for which particular attention must be  given. 

This is not intended to be an exhaustive list of all possible uses of the products, nor is it 

intended to imply that the uses may be suitable for the products: 

●​ Systems, machines, and equipment that could present a risk to life or property. 

●​ Nuclear energy control systems, combustion systems, railroad systems, aviation 

systems, medical equipment, amusement machines, vehicles, safety equipment, and 

installation subject to separate industry or government regulations. 

●​ Outdoor use, uses involving potential chemical contamination or electrical 

interference, or conditions or uses not described in this document. 

 

At the customer’s request, INDUSTRIAL SHIELDS will provide applicable third party certification 

documents identifying ratings and limitations of use that apply to the products. This 

information by itself is not sufficient for a complete determination of the suitability of the 

products in combination with the system, machine, end product, or other application or use. 
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  Intended use or of Industrial Shields products                                                  

Consider the following: 

Industrial Shields products should only be used for the cases of application foreseen in the 

catalogue and the associated technical documentation. If third-party products and components 

are used, they must have been recommended or approved by Industrial Shields.  

The correct and safe operation of the products requires that your transport, storage, 

installation, assembly, operation and maintenance have been carried out in a correct manner. It 

must respect the permissible ambient conditions. You should also follow the indications and 

warnings that appear in the associated documentation. 

The product / system dealt with in this documentation should only be handled or manipulated 

by qualified personnel for the task entrusted and observing what is indicated in the 

documentation corresponding to it, particularly the safety instructions and warnings included 

in it. Due to their training and experience, qualified personnel are in a position to recognize 

risks resulting from the handling or manipulation of such products / systems and to avoid 

possible hazards. 

  Disclaimers             

Weights and Dimensions 

Dimensions and weights are nominal and they are not used for manufacturing purposes, even 

when tolerances are shown. 

Performance Data 

The performance data given in this manual is provided as a guide for the user in determining 

suitability and does not constitute a warranty. It may represent the result of INDUSTRIAL 

SHIELDS’s test conditions, and the users most correlate it to actual application requirements. 

Actual performance is subject to the INDUSTRIAL SHIELDS Warranty and Limitations of Liability. 

Errors and Omissions 

The information in this document has been carefully checked and is believed to be accurate; 

however, no responsibility is assumed for clerical, typographical, or proofreading errors, or 

omissions. 

The control and drive components of an Industrial Shields PLC are approved for industrial and 

commercial use in industrial line supplies. Their use in public line supplies requires a different 

configuration and/or additional measures. These components may only be operated in closed 

housings or in higher-level control cabinets with protective covers that are closed, and when all 

of the protective devices are used. These components may only be handled by qualified and 

trained technical personnel who are knowledgeable and observe all of the safety information 

and instructions on the components and in the associated technical user documentation. 
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When carrying out a risk assessment of a machine in accordance with the EU Machinery 

Directive, the machine manufacturer must consider the following residual risks associated with 

the control and drive components of a PDS.  

1. Unintentional movements of driven machine components during commissioning, operation, 

maintenance, and repairs caused by, for example: − Hardware defects and/or software errors in 

the sensors, controllers, actuators, and connection technology − Response times of the 

controller and drive − Operating and/or ambient conditions not within the scope of the 

specification − Condensation / conductive contamination − Parameterization, programming, 

cabling, and installation errors − Use of radio devices / cellular phones in the immediate 

vicinity of the controller − External influences / damage.  

2. Exceptional temperatures as well as emissions of noise, particles, or gas caused by, for 

example: − Component malfunctions − Software errors − Operating and/or ambient 

conditions not within the scope of the specification − External influences / damage. 

3. Hazardous shock voltages caused by, for example: − Component malfunctions − Influence of 

electrostatic charging − Induction of voltages in moving motors − Operating and/or ambient 

conditions not within the scope of the specification − Condensation / conductive 

contamination − External influences / damage  

4. Electrical, magnetic and electromagnetic fields generated in operation that can pose a risk to 

people with a pacemaker, implants or metal replacement joints, etc. if they are too close.  

5. Release of environmental pollutants or emissions as a result of improper operation of the 

system and/or failure to dispose of components safely and correctly. 
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  Warranty and Limitations of Liability 

Warranty 

Industrial Shields’s exclusive warranty is that the products are free from defects in materials 

and workmanship for a period of one year (or other period if specified) from date of sale by 

Industrial Shields. 

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY, EXPRESSED OR IMPLIED, 

REGARDING MERCHANTABILITY, NON-INFRINGEMENT, OR FITNESS FOR PARTICULAR PURPOSE 

OF THE PRODUCTS. ANY BUYER OR USER ACKNOWLEDGES THAT THE BUYER OR USER ALONE 

HAS DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET THE REQUIREMENTS OF THEIR 

INTENDED USE. INDUSTRIAL SHIELDS DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR 

IMPLIED 

 

Limitations of Liability 

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT, OR CONSEQUENTIAL 

DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN ANY WAY CONNECTED WITH THE 

PRODUCTS, WHETHER SUCH CLAIM IS BASED ON CONTRACT, WARRANTY, NEGLIGENCE, OR 

STRICT LIABILITY. 

IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONSIBLE FOR WARRANTY, REPAIR OR OTHER 

CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL SHIELDS’S ANALYSIS CONFIRMS THAT 

THE PRODUCTS WERE PROPERLY HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT 

SUBJECT TO CONTAMINATION, ABUSE, MISUSE, OR INAPPROPRIATE MODIFICATION OR REPAIR. 
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1​ General Description ESP32 ETHERNET & WIFI & 

BLUETOOTH PLC FAMILY Product 

1.1​ Zones Table 

 

1.2​ Measures Table 
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1.3​ Zone - Nomenclature 

The nomenclature shown in this point will be used in the whole user guide, in order to refer to 

the different parts of the PLC. It is important to understand this nomenclature to fully grasp the 

contents  of the user guide.  

The nomenclature to differentiate the zones is based on alphanumeric values, being 0 the 

internal communication shield and A, B or C the I/Os or relay shields. 

 

  

 

 

 

 

 

 

●​ The inputs in the A/B/C zones are named IX.X, being X any suitable number in the 
Shield. Outputs are named QX.X. 

1.4​ Zone Distribution 

 

This is the possible zones scheme, whether the zone is Analog/Digital or Relay depends on your 

device model, which can be consulted on the Zones Table. The distribution of the different 

features provided by the ESP32 PLC Family are described below. 
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1.5​ Zone Features 

Shield Zone Characteristics 

Communication Shield 

(1x) Ethernet 

(1x) WiFi 

(1x) BLE 

(1x) VN/VP 

(2x) Serial TTL 

(1x) I2C 

(1x) RS-232 

(1x) Half Duplex RS-485 

(1x) SPI external port 

(1x) RTC 

(1x) uSD Socket 

 

 

Analog Shield 

 

13 Inputs: 

 

8 Outputs: 

 

 

13 digital inputs, 6 of which can work as analog input. 

 

8 digital outputs, 3 of which can work as analog output. All of 

them can work as PWM output. 

Relay Shield 

 

6 Inputs: 

 

11 Outputs: 

 

6 digital inputs, 4 of which can work as analog input. 

 

8 relay outputs. 

3 digital outputs, 3 of which can work as analog output. 

All of them can work as PWM output. 
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1.6​ Mechanical dimensions 

​
 

*NOTE: This device includes one 2.4GHz antenna and one 4G antenna (for the 4G option), both 

with a 5 cm length. 
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1.7​ General Features 

ESP32 ETHERNET & WIFI & BLUETOOTH PLC FAMILY  

MODEL TYPE Controller General Specifications Information 

Input Voltage 
12 to 24Vdc 

 
Fuse protection (2.5A) 

Polarity protection 

Input rated voltage 
24Vdc 

 
 

Rated Power 30W  

I max. 1.5A  

Size Consult the 1.6 Measure Table section  

Clock Speed 
External: adjustable from 80MHz to 240MHz   Internal: 

8MHz 
 

External Flash Memory 4MB  

SRAM 520KB  

ROM 448KB  

Communications 
I2C  –  Ethernet Port – WiFi – BLE  – RS485 (HD) – RS232 – 

SPI – SerialTTL – VN/VP 
Max232-Max485-W5500 

USB consideration! 
Only meant for uploading or debugging, not always 

connected as a serial in a project! 
Cannot be working in a final 

application 

An/Dig Input 11 bit 
(0-10Vcc) 

0 to 10Vdc 
Input Impedance: 39K 
Separated PCB ground 
Rated Voltage: 10Vdc 

 
5 to 24Vdc 

I min: 2 to 12mA 
Galvanic Isolation 

Rated Voltage: 24Vdc 
 
 

Max read time: 2ms 
 

*Check Section 17 for digital 
inputs threshold detection 

 

Digital Isolated Input 
(24Vcc) 

5 to 24Vdc 
I min: 2 to 12mA 
Galvanic Isolation 

Rated Voltage: 24Vdc 
 
 

Max read time: 470us 

* Interrupt isolated Input 
HS (24Vcc) 

5 to 24Vdc 
I min: 2 to 12mA 
Galvanic Isolation 

Rated Voltage: 24Vdc 
 
 

Max read time: 1us 

Analog Output 12 bit 
(0-10Vcc) 

0 to 10Vdc 
I max: 20mA 

Separated PCB ground 
Rated Voltage: 10Vdc 

 

Output frequency: 4.5Hz 
 

Rising edge time: 157.6ms 
Falling edge time: 221.6ms 

Digital Isolated Output 
(24Vcc) 

5 to 24Vdc 
I max: 70mA 

Galvanic Isolation 
Diode Protected for Relay 

Rated Voltage: 24Vdc 
 
 

Imax 24Vdc: 410mA 
 

Max frequency: 406.5Hz 
with pulse width of 2.02ms 

 
Rising edge time: 92.4us 
Falling edge time: 0.5 s  

Relay Output 
(30Vdc / 250Vac) 

30Vdc / 250Vac 
Galvanic Isolation 

Diode protected for Relay 
 

Imax: 3A (30Vdc) 
Imax: 5A (250Vac) 
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PWM Isolated Output 12 
bit (24Vcc) 

5 to 24Vdc 
I max: 70mA 

Galvanic Isolation 
Diode Protected for Relay 

Rated Voltage: 24Vdc 
 

 

Direct ESP32 Pins  

SCL/SDA: 
Rising edge time: 2us 

Falling edge time: 200us 
 

TX2: 
Output frequency: 1.026MHz 

Rising edge time: 100ns 
Falling edge time: 100ns 

 
RX: 

Max read time: 1us 
 

SO/SI/SCK: 
Rising edge time: 100ns 
Falling edge time: 100ns 

Expandability I2C - 127 elements   -  Serial Port RS232/RS485  

* By using this type of signal can no longer use Digital signal (24Vdc)  
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1.8​ Power consumption of the ESP32 Family PLCs 

Model Current resting 
(mA) 

Power resting 
(W) 

Current active 
(mA) 

Power active  
(W) 

21+ 90 2,16 102 2,448 

42+ 89 2,136 116 2,784 

58+ 77 1,848 120 2,88 

19R+ 72 1,728 191 4,584 

38R+ 73 1,752 304 7,296 

57R+ 76 1,824 415 9,96 

38AR+ 73 1,752 209 5,016 

53ARR+ 75 1,8 319 7,656 

57AAR+ 75 1,8 221 5,304 

54ARA+ 78 1,872 226 5,424 

50RRA+ 78 1,872 328 7,872 

 

The power consumption is measured at 24Vdc.  

The current resting column denotes the minimum current drawn by the PLC when all outputs 
are at a LOW level, representing the PLC's baseline power consumption. 

In contrast, the current active column reflects the current drawn by the PLC when all outputs 
are at a HIGH level, and there are no connections to any of the outputs. While this value is not 
the absolute maximum the ESP32 based PLC can draw, it serves as a reference point for 
expected current values. 

It's important to note that the practical maximum current may vary depending on the type of 
actuators connected to the outputs and the number of I/Os used. The actual consumption can 
be influenced by the specific configuration and load connected to the PLC's outputs." 

 

​
​
​
​
​
​
​
​
​
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2​ Technical Specifications 

2.1​ General Specifications 

Item ESP32 ETHERNET & WIFI & BLUETOOTH PLC 

Power supply 
voltage 

DC power supply    12 to 24 Vdc  

Operating 
voltage range 

DC power supply 11.4 to 25.4 Vdc 

Power 
consumption 

DC power supply 30 W max. 

External 
power supply 

Power supply 
voltage 

24 Vdc 

Power supply 
output capacity 

700 mA 

Dielectric strength 1500 Vac at 50/60 Hz for one minute with a leakage current of 10 mA max. 

Shock resistance 
50 m/s² in the X, Y and Z direction 3 times each, complying with the 
IEC-60068-2-27:2008 standard. 

Ambient temperature 
(operating) 

-20 º to 70 ºC 

Ambient humidity (operating) 10 % to 90 % (no condensation) 

Ambient environment 
(operating) 

With no corrosive gas 

Ambient temperature (storage) -20 º to 70 ºC 

Power supply holding time 2 ms min. 

Weight See the measure table. 
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2.2​ Performance Specification 

Board ESP32-WROOM-32UE  

Control method Stored program method 

I/O control method Combination of the cyclic scan and immediate refresh processing methods. 

Programming language 
Arduino IDE. Based on wiring (Wiring is an Open Source electronics platform composed of a 
programming language. (We recommend at least version 1.8.13). 
http://arduino.cc/en/Tutorial/HomePage 

Microcontroller ESP32 

External Flash Memory 4MB 

Program capacity (SRAM) 520KB 

SRAM in RTC 16KB 

Clock Speed Adjustable from 80 MHz to 240 MHz 

 

 

2.3​ Peripheral ports - USB & SIM Card Slot & Antennas 

●​ The microUSB type B port for programming is located at the right side of the PLC 

enclosure. 

●​ The SIM card slot is also located at the right side of the PLC enclosure. 

●​ Additional Wi-Fi antenna with SMA female connector (on the frontal top side) included 

with the PLC.  

●​ Expansion board antenna (if required) with SMA female connector (on the frontal top 

side) included with the PLC.  
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2.4​ Symbology 

Table including the symbology used in the ESP32 ETHERNET & WIFI & BLUETOOTH PLC 

serigraph. 

 I/Os Analog/Digital PLUS: 

Symbol 
Standard No. / 
Standard Title 

Standard Reference 
No. / Symbol Title 

Symbol Meaning 

 

IEC 60417 / 
Graphical symbols 

for use on 
equipment 

5031 / Direct 
Current 

Indicates that the equipment is 
suitable for direct current only; to 

identify relevant terminals 

 

IEC 60417 / 
Graphical symbols 

for use on 
equipment 

5032 / Alternating 
Current 

Indicates that the equipment is 
suitable for alternating current 

only; to identify relevant 
terminals 

 IEC 60417 / 
Graphical symbols 

for use on 
equipment 

5130 / Pulse General 
To identify the control by which a 

pulse is started. 

 IEC 60417 / 
Graphical symbols 

for use on 
equipment 

5017 / Earth, 
Ground 

To identify an earth (ground) 
terminal in cases where neither 

the symbol 5018 nor 5019 is 
explicitly required. 

 
IEC 60417 / 

Graphical symbols 
for use on 
equipment 

 

5115 / SIgnal lamp 
To identify the switch by means 

of which the signal lamp(s) is 
(are) switched on or off. 

 
2004/108/EC / 

Electromagnetic 
Compatibility 

CE Marking 
CE marking indicates that a 

product complies with applicable 
European Union regulations 

 
 

ISO 7000/ Graphical 
symbols for use on 

equipment 
 

0434B / 
Warning symbol 

Indicates a potentially hazardous 
situation which, if not avoided, 
could result in death or serious 

injury 

 ISO 7000/ Graphical 
symbols for use on 

equipment 
 

5036 / Dangerous 
Voltage 

To indicate hazards arising from 
dangerous voltages 
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3​ Precautions 

Read this manual before attempting to use the ESP32 ETHERNET & WIFI & BLUETOOTH PLC and 
follow its descriptions for reference during operation. 

3.1​ ESP32 Board 

This version of PLC includes an ESP32 Board as controller.  

3.2​ Intended Audience 

This manual is intended for technicians with knowledge on electrical systems. 

3.3​ General Precautions 

The user must operate ESP32 ETHERNET & WIFI & BLUETOOTH PLC according to the 

performance specifications described in this manual. 

Before using ESP32 ETHERNET & WIFI & BLUETOOTH PLC under different conditions from what 

has been specified in this manual or integrating ESP32 ETHERNET & WIFI & BLUETOOTH PLC to 

nuclear control systems, railroad systems, aviation systems, vehicles, combustion systems, 

medical equipment, amusement machines, safety equipment and other systems, machines, 

and equipment that may have a serious influence on lives and property if used improperly, 

consult your INDUSTRIAL SHIELDS representative. Ensure that the rating and performance 

characteristics of ESP32 ETHERNET & WIFI & BLUETOOTH PLC are sufficient for the systems, 

machines, and equipment, and be sure to provide the systems, machines, and equipment 

double safety mechanisms. This manual provides information for programming and operating 

the ESP32 ETHERNET & WIFI & BLUETOOTH. 

3.4​ Isolation Precautions 

Description: 

This equipment does not include galvanic isolation between the grounds of the different 

systems. This means that if an external device or sensor that shares the same ground reference 

(GND) with the system is connected, any potential difference between these grounds could 

damage the connected components. To avoid issues with interference, ground loops, or 

damage to external equipment, ensure that all connected devices share the same ground 

reference or use systems with appropriate isolation. 

Recommendations: 

●​ Connection Review: Verify that all ground connections are properly made and that 

there are no significant potential differences between them. 

●​ Use of Isolation: Consider using galvanic isolators or isolation transformers if it is 

necessary to connect equipment with different ground references.  
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4​ Software interface 

Industrial Shields PLCs are programmed using Arduino IDE, which is a software based on the C 

language. They can also be programmed directly using C but it is much easier working with 

Arduino IDE as it provides lots of libraries that help in the programming.   

Industrial Shields provide a boards package for programming the PLCs, making it easier and 

friendlier. It includes various facilities such as not having to define the pins, etc. 

In order to install the Industrial Shields boards package, follow these steps. 

Requirements: 

Arduino IDE 1.8.13 or above (recommended: 1.8.19). 

Steps: 

1.​ Open Arduino IDE and go to: “File -> Preferences” located in the top left corner. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2.​ In Additional Boards Manager URLs write the following: 

http://apps.industrialshields.com/main/arduino/boards/package_industrialshields_index.json 

3.​ Press OK to save the changes. 

4.​ Tools -> Board: … -> Boards Manager. Search for the industrialshields-esp32 board and 

install the last version (it must be from the version 2.0.2 minimum): 
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Following these steps, you will be able to see now the Industrial Shields Boards: 

  

 

Once the ESP32 PLC Family is selected, an extra option will appear on “Tools”. 

There, the exact model for each family can be selected. 

In addition, there are some programming examples in “File -> Examples -> ESP32 PLC Family”. 

Furthermore, some extra libraries that can be found in the Industrial Shields GitHub. 

https://github.com/Industrial-Shields/ 
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5​ How to connect the ESP32 PLC to PC 

●​ Connect micro-USB port from PLC to PC 

NOTE:  
ESP32 ETHERNET & WIFI & BLUETOOTH PLC  
uses micro-USB type B cable.  
 
 
 

●​ Open Arduino IDE interface 
 

●​ Select Industrial Shields boards -> ESP32 PLC Family 
 
 

 
 
 

●​ Select the correct ESP32 PLC Model: 
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●​ Select the latest version. 

 
 
 
 

●​ Select the right extension modules (if required: if you have purchased the device with 

them by default). 
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●​ Select the correct port for your board  
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6​ How to connect PLC to power supply 

●​ ESP32 ETHERNET & WIFI & BLUETOOTH PLC is 12-24Vdc supplied. IMPORTANT: The 

polarity IS NOT REVERSIBLE!  

●​ Make sure that the live and GND connector of the power supply match the PLC. 

●​ Make sure that the power supply main output is not higher than 24Vdc. 

 

  

●​ Suggested power suppliers 

Compact DIN rail power supply. Assembled on 35mm DIN Rail:​
-12Vdc / 24Vdc​
-2.5A​
-30W​
​
Industrial Shields power supplies provide parallel operation, overvoltage protection, and overcurrent 

protection. There is a LED inductor for power status, the power supply is certified according to UL. 

 

The standard, Part 1 of IEC 61010, sets the general safety requirements for the following types 

of electrical devices and their accessories, regardless of where use of the device is intended.  

The equipment must be powered from an external power source in accordance with IEC 

61010-1, whose output is MBTS and is limited in power according to section 9.4 of IEC 61010-1. 

WARNING: Once the equipment is installed inside an electrical cabinet, the MTBS cables of the 

equipment must be separated from the dangerous voltage cables. 
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7  ESP32 ETHERNET & WIFI & BLUETOOTH PLC Pinout 

7.1​ I/Os Table 

 

 

7.2​ 0 Zone connection 

Base 
(common unit) 

A Zone 

PLC Function 

3.3Vdc 
5Vdc 
GND 

3.3Vdc 
5Vdc 
GND 
SCL 
SDA 
GND 
TX1 
RX1 
GND 
RX2 
TX2 
VN 
VP 
B- 
A+ 

GND 
SO 
SI 

SCK 
GPIO 0 
5Vdc 

TX 
RX 

- 
- 
- 
- 
- 
- 

GPIO 22 
GPIO 21 

- 
TX1 
RX1 

- 
RX2 
TX2 

SENS VN 
SENS VP 

RS485 
RS485 
RS485 

GPIO 19 
GPIO 23 
GPIO 18 

- 
5V 

RS232 
RS232 
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Base 
(common unit) 

A Zone 

PLC Function 

Vdc 
GND 

Power Supply 
GND 

   

 

 

 

 

 

 

 

 

 

 

NOTE: Slots or indications related to the Extension modules are clearly pointed out on the 

serigraphy of the device.  
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7.3​ Analog/Digital Zone connection (I/Os) 

X Zone 

ESP32 
PLC 

Connector 
Function  

IX.12 
IX.11 
IX.10 
IX.9 
IX.8 
IX.7 

(-)IX.6 
IX.6/INT1 

(-)IX.5 
IX.5/INT1 

(-)IX.4 
IX.4 

(-)IX.3 
IX.3 

(-)IX.2 
IX.2 

(-)IX.1 
IX.1 

(-)IX.0 
IX.0 

Analog / Digital In 
Analog / Digital In 
Analog / Digital In 
Analog / Digital In 
Analog / Digital In 
Analog / Digital In 

GND I0.6 
Interrupt X In 

GND I0.5 
Interrupt X In 

GND I0.4 
Digital Input 

GND I0.3 
Digital Input 

GND I0.2 
Digital Input 

GND I0.1 
Digital Input 

GND I0.0 
Digital Input 

 

 

 

 

X Zone 

ESP32 
PLC 

Connector 

 
  
 

Function  

GND 
AX.72 
AX.62 
AX.52 
Q/Vdc 
COM(-) 
QX.72 
QX.62 
QX.52 
QX.4 
QX.3 
QX.2 
QX.1 
QX.0 

GND 
Analog Out 
Analog Out 
Analog Out 

External Isolated Out Vdc 
External Isolated Out GND 

Digital/PWM Out 
Digital/PWM Out 
Digital/PWM Out 

Digital Out 
Digital Out 
Digital Out 
Digital Out 
Digital Out 

  

 

 

2 See Section 8 to select the correct configuration for outputs. 

1 See the Interrupt Equivalence Table. 
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7.4​ Relay Zone connection (I/Os) 

X Zone 

ESP32 
PLC 

Connector 
   Function 

RX.8 
RX.7 
RX.6 
RX.5 
RX.4 
AX.23 
AX.13 
AX.03 
GND 
QX.23 
QX.13 
QX.03 

GNDCOM 
24VCOM 

Relay Out 
Relay Out 
Relay Out 
Relay Out 
Relay Out 

Analog Out 
Analog Out 
Analog Out 

GND  
Digital/PWM Out 
Digital/PWM Out 
Digital/PWM Out 

External Isolated Out GND 
External Isolated Out Vdc 

 

 

  

 

 

 

 

C Zone 

ESP3
2 PLC 
Conn
ector 

 
  
 
 
 

Function  
RX.3 
RX.2 
RX.1 
GND 
IX.5 
IX.4 
IX.3 
IX.2 

IX.1/INT4 
(-)IX.1 

IX.0/INT4 
(-)IX.0 

 

Relay Out 
Relay Out 
Relay Out 

GND 
Analog/Digital Input 
Analog/Digital Input 
Analog/Digital Input 
Analog/Digital Input 

Interrupt X In 
GND I0.1 

Interrupt X In 
GND I0.0 

 

 

  

4 See the Interrupt Equivalence Table. 

3 See Section 8 to select the correct configuration for outputs. 
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7.5​ Interrupt equivalence table 

ZONE ANALOG/DIGITAL RELAY ESP32 PIN 

A 
0.5 0.0 27 
0.6 0.1 26 

B 
1.5 1.0 35 
1.6 1.1 25 

C 
2.5 2.0 34 
2.6 2.1 5 
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8​ Switch Configuration 

8.1​ 0 Zone: Communications  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

RS484/Serial1/RS232/Serial2/EXP2: This switch configuration can be done following the 

previous table to select among RS485 or Serial1 and RS232 or Serial2 or EXP2 (Expansion shield 

2).  

 

8.2​ Analog / Digital Zone 

ZONE A  ZONE B  ZONE C 

SWITCH ON OFF  SWITCH ON OFF  SWITCH ON OFF 

NC - -  NC - -  NC - - 
Q0.7 Q0.7 A0.7  Q1.7 Q1.7 A1.7  Q2.7 Q2.7 A2.7 
Q0.6 Q0.6 A0.6  Q1.6 Q1.6 A1.6  Q2.6 Q2.6 A2.6 
Q0.5 Q0.5 A0.5  Q1.5 Q1.5 A1.5  Q2.5 Q2.5 A2.5 
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8.3​ Relay Zone 

ZONE A  ZONE B  ZONE C 

SWITCH ON OFF  SWITCH ON OFF  SWITCH ON OFF 

NC - -  NC - -  NC - - 
Q0.2 Q0.2 A0.2  Q1.2 Q1.2 A1.2  Q2.2 Q2.2 A2.2 
Q0.1 Q0.1 A0.1  Q1.1 Q1.1 A1.1  Q2.1 Q2.1 A2.1 
Q0.0 Q0.0 A0.0  Q1.0 Q1.0 A1.0  Q2.0 Q2.0 A2.0 

 

For the Analog Shield if a switch is set to ON, it can only act as Digital Output. If it is set to OFF, 

it can only act as an Analog Output. 

If it is desired to use a Digital Output the pin must be set to ON and the pin that will provide 

this digital output is represented with QX.X, being X any number of the tables above. 

If it is desired to use an Analog Output the pin must be set to OFF and the pin that will provide 

this analog output is represented with AX.X, being X any number of the tables above. 
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9​ Software set up 

Whether they are digital or relay, the inputs and outputs must be configured in the set up part 

of the code, like it is usually done in common Arduino boards. The function  that must be used 

is pinMode(), like it is explained on the official Arduino website:  

https://www.arduino.cc/reference/en/language/functions/digital-io/pinmode/ 

 

9.1​ Example​  

If you want to configure an input, it can be done this way:  

pinMode(I0_0, INPUT); 
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If you want to configure an output, it can be done this way:  

pinMode(Q0_5, OUTPUT); 
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10​ I/O ESP32 PLC 3.3V/5V pins 

The ESP32 ETHERNET & WIFI & BLUETOOTH PLC has some of the ESP32 board pins available.  

These pins can be programmed according to ESP32 features such as I/O’s operating at 3.3Vdc 

or any additional features present in the pins. It also must be considered that some of them 

work at 5Vdc. As most of these pins are directly connected to the ESP32 board, they are not as 

well protected as the normal inputs. These pins are mainly meant to be used as prototyping. 

The ESP32 PLC board available pins are summarised in the table below. In order to access these 

pins some extra considerations must be taken in consideration. 

 

Operating Voltage: 3.3Vdc 

PLC terminal ESP32 pin 
A+ (RS-485) RS-485 

B- (RS-485) RS-485 

TX1 TX1 

RX1 RX1 

TX2 TX1 

RX2 RX1 

VN SENS VN 

VP SENS VP 

SO  GPIO 19 

SI  GPIO 23 

SCK  GPIO 18 

 

*IMPORTANT: Do not connect the terminals in the chart above to voltages higher than 3.3Vdc. 

These terminals provide direct access to the ESP32 board. 

There are some special conditions depending on these 3.3Vdc. In the next sections are going to 

be shown the considerations to operate with these pins. 

 

Operating Voltage: 5Vdc 

PLC terminal ESP32 pin 
SCL GPIO 22 

SDA GPIO 21 

TX (RS-232) RS-232 

RX (RS-232) RS-232 

 

*IMPORTANT: Do not connect the terminals in the chart above to voltages higher than 5Vdc.  

There are some special conditions depending on these 5Vdc. In the next sections are going to 

be shown the considerations to operate with these pins.  
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10.1​ I2C 

I2C communication DOES NOT REQUIRE a pull-up resistor for the ESP32 ETHERNET & WIFI & 

BLUETOOTH PLC, as the pull-up resistor is already implemented in the PCB.  

*IMPORTANT:  Using the I2C pins as direct pins sidables the I2C bus, which means some 

functionalities of the PLC, such as the inputs/outputs, will be unavailable. 

10.2​Serial 1 – RX1/TX1 

The Serial1 protocol works as a 3.3V pin. To know how to configure these pins correctly, check 

section 8 and section 15. If not using the Serial 1 interface these pins can work as digital, either 

input or output.   

These pins are not established with a pull-up or a pull-down configuration. The state of these 

pins is unknown. If these pins must be used, they require a pull-up or a pull-down 

configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not, 

they must be configured as an external pull-up or pull-down circuit in order to correctly work. 

10.3​Serial 2 – RX2/TX2 

The Serial2 protocol works as a 3.3V pin. To know how to configure these pins correctly, check 

section 8 and section 15. If not using the Serial 1 interface these pins can work as digital, either 

input or output.  

These pins are not established with a pull-up or a pull-down configuration. The state of these 

pins is unknown. If these pins must be used, they require a pull-up or a pull-down 

configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not, 

they must be configured as an external pull-up or pull-down circuit in order to correctly work. 

10.4​SPI – MISO/MOSI/SCK 

The ESP32 ETHERNET & WIFI & BLUETOOTH PLC pins used for the SPI bus are summarised in 

the table below. For SPI bus MISO, MOSI and CLOCK pins are common to all the connected 

devices to the ESP32 ETHERNET & WIFI & BLUETOOTH PLC. Each of the connected devices will 

have a single and dedicated SS pin.  

Function PLC connection 
MISO  S0 
MOSI  SI 
CLOCK SCK 
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11​ A Zone Features: Communications & RTC & uSD 

11.1​RS-232 

For the RS-232 communication protocol there is a switch that affects it. See Section 8 for more 

information.  

Using the boards of Industrial Shields, you only have to initialise the port with the function 

RS232.begin(<baud rate>); in the setup part and then you can use the RS-232 with the 

common serial functions: RS232.read(); and RS232.write();. 

11.2​RS-485 (Half Duplex) 

For the RS-485 communication protocol there is a switch that affects it. See Section 8 for more 

information.  

The Industrial Shields boards package includes a library to simplify the use of the RS-485. 

11.3​Ethernet 

ESP32 ETHERNET & WIFI & BLUETOOTH PLC Ethernet port controller is based on W5500 IC, 

which is the IC compatible with Arduino Ethernet Shield libraries. All Ethernet shield Arduino 

libraries are compatible with the ESP32 ETHERNET & WIFI & BLUETOOTH PLC.  

11.4​BLE 

This device has Bluetooth Low Energy provided by the ESP32. It uses the 4.2 BR/EDR version 

and BLE. The BLE is optimised for short burst data transmission, it uses the 2.4GHz ISM Band, 

40 channels (w/ 2MHz spacing), the channel usage method of FHSS, the GFSK modulation. It 

has a power consumption of ~0.01x to 0.5x of reference (it depends on specific usage). It can 

be used on different network topologies: mesh, broadcast and point-to-point.  

11.5​RTC 

ESP32 ETHERNET & WIFI & BLUETOOTH PLC RTC Module is based on the DS1307 Chip. This chip 

works with the I2C protocol communication, so it is required to have enabled the I2C protocol.  

Using the boards of Industrial Shields, there is a library that simplifies the RTC implementation 

called RTC.  
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11.6​ I2C pins – SDA/SCL 

The I2C protocol is meant to work in a pull-up configuration. A pull-up configuration means 

that when the pin is at rest (nothing connected to it) it always reads a HIGH value. In this case it 

reads 5V when nothing is connected. The pull-up configuration is established by default in 

these pins. 

 If it is meant to work as a GPIO at 5V, it must be considered that they are pull-up inputs. 

11.7​SPI – MISO/MOSI/SCK 

These pins can only work as a 3.3V if the Ethernet protocol is not going to be used. As the 

Ethernet protocol uses the SPI to communicate with the ESP32 board, both behaviours cannot 

happen at the same time as the Ethernet would not work. 

These pins are not established with a pull-up or a pull-down configuration. The state of these 

pins is unknown. If these pins must be used, they require a pull-up or a pull-down 

configuration. The ESP32 board allows the pins to be set in a pull-up configuration. If not, it 

must be established as an external pull-up or pull-down circuit in order to correctly work with 

these pins.    

11.8​uSD 

The microSD uses the SPI communication to interact with the ESP32. The SPI protocol is always 

enabled, as there are no switches that configure it.  

Using Industrial Shields boards there is a library that simplifies the uSD implementation called 

SD. 

The following tested microSD models are recommended: 

Brand Model 
Capacity 

(GB) 
Type 

Random 
Access 
Class 

Speed 
Class 

UHS 
Class 

Video 
Speed 

Product Code/Lot 

ATP AF8GUD4A-BBBIM 8 SDHC º10 A1 U3 V30 
1G08G2210 

TVHN003823233 

Kingston SDC10-16GB 16 SDHC º10 A1 U1 V10 N0541-003.A00LF 
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11.9​GPIO_0 

The GPIO_0 is a pin which works at 5Vdc and can be used as a digital input or digital output in 

function of the programming. It cannot be used with sensors like the DS18B20. It can be 

defined in the setup block: 

pinMode(GPIO_0,INPUT); 

 

Or:  

pinMode(GPIO_0,OUTPUT); 

 

It can be used as a digital input: 

digitalRead(GPIO_0); 

 

Or as a digital output: 

digitalWrite(GPIO_0, HIGH); 

 

Or: 

digitalWrite(GPIO_0, LOW); 

 

  Verify that the CPU is not actively running a process before inserting the memory card.  

Inserting a memory card will cause the CPU to go to STOP mode, which could affect the 

operation of an online process or machine. Unexpected operation of a process or machine 

could result in death or injury to personnel and/or property damage. Before inserting a 

memory card, always ensure that the CPU is offline and in a safe state. 

  Vérifiez que le processeur n'exécute pas activement un processus avant d'insérer la 

carte mémoire. 

Si vous insérez une carte mémoire, la CPU passe en mode STOP, ce qui peut affecter le 

fonctionnement d'un processus ou d'une machine en ligne. Le fonctionnement inattendu d'un 

processus ou d'une machine peut entraîner la mort ou des blessures corporelles et / ou des 

dégâts matériels. Avant d'insérer une carte mémoire, assurez-vous toujours que la CPU est hors 

ligne et en sécurité.  
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12​ Additional Features 

12.1​Expansion modules 

This device has a system of 2 optional expansion modules. Each one of them is an additional 

internal board that can be selected by the client when the device is purchased:  

12.1.1​4G LTE / GPRS / GSM /NB1 
The 4G LTE / GPRS / GSM / NB1 expansion board uses the SARA-R412M-02B-03 microchip, 

which has the following features: 

●​ Model: SARA-R412M-02B-03 

●​ Type: 2G EGPRS, GSM/4G LTE, M1/NB1 (Narrow-Band) 

●​ Key Features: : LTE FDD Bands (2/3/4/5/8/12/13/20/26/28), 2G Bands (850-1900MHz), 

LTE Category M1/NB1, 2G GMSK, 2G 8-PSK, LTE Category M1, LTE Category NB1, GPRS 

Multi-slot class 33, EGPRS multi-slot class 33 

●​ Applications: Remote monitoring automation, asset tracking, surveillance and security, 

home automation systems, point of sales terminals etc. 

12.1.2​ CAN 
The CAN expansion board uses the MCP2515 microchip, which has the following features: 

●​ Model: MCP2515 

●​ Type: CAN V2.0B 

●​ Key Features: Speed of 1Mb/s, receive buffers, masks and filters, data byte filtering on 

the first two data bytes, three transmit buffers with prioritization and abort features, 

high speed SPI interface (10MHz), etc. 

●​ Applications: Communication with all kinds of CAN devices and the protocols that can 

be applied to this communication method. 

12.1.3​ LoRa 
The LoRa expansion board can use the RN2483 or RN2903 microchip depending on the 

frequency needed, which have the following features: 

●​ Model: RN2483 (for Europe/Asia), RN2903 (for North America/Australia) 

●​ Type: LoRa 

●​ Key Features: On-board LoRaWAN protocol stack, ASCII command interface over UART, 

Castellated SMT pads for easy and reliable PCB mounting, Environmentally friendly, 

RoHS compliant, Device Firmware Upgrade (DFU) over UART, etc. 

●​ Applications: Automated Meter Reading, Home and Building Automation, Wireless 

Alarm and Security System, Industrial Monitoring and Control, Machine to Machine 

(M2M), Internet of Things (IoT), etc. 
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12.1.4​ GPS 
The GPS expansion board uses the L80 microchip, which has the following features: 

●​ Model: L80-M39 

●​ Type: GPS 

●​ Key Features: GPS L1 1575.42 MHz C/A Code, 66 search channels, 22 simultaneous 

tracking channel, Max Update Rate up to 10 Hz, 1 Hz by default, Velocity Accuracy 

without aid: 0.1 m/s, Acceleration Accuracy without aid: 0.1 m/s², etc. 

●​ Applications: High performance of MTK positioning engine to the industrial 

applications with top level of sensitivity, accuracy and TTFF in the industry with the 

minimum power consumption. 
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13​ Equivalence Table  

The Digital/Analog I/Os of this device are connected to the ESP32 through I2C, using specific 

chips (see the Section 14). Here we have the equivalence tables (using Industrial Shields 

libraries, we do not have to consider these equivalences): 

13.1​Pin-Out 

13.1.1​Analog/Digital Devices Analog I/Os 
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13.1.2​ Digital I/Os  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

13.1.3​ Relay Devices Analog I/Os 
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13.1.4​ Digital I/Os 
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13.1.5​ Relay 
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14​ Internal I2C and SPI Connections  
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15​ Instructions: How to upload a program 

Uploading a program to your ESP32 PLC is usually straightforward. However, if you encounter 

issues such as the upload process getting stuck, receiving an error, or being unable to use the 

serial monitor, follow these steps to resolve the problem. 

Step 1: Verify the Switch Position Next to the microUSB Port 

●​ Switch on the Left (Programming Mode): This is the default mode that allows 

uploading code and using the serial monitor. 

●​ Switch on the Right (Boot Mode): This mode is typically used for boot-related 

operations and may prevent normal programming or serial monitoring. 

If the switch next to the microUSB port is on the right (Boot Mode), move it to the left 

(Programming Mode) and attempt to upload the program again. 

Step 2: Troubleshooting Further Issues 

If the switch was already in the correct position (left) and you are still experiencing problems, 

follow these steps: 

1.​ Connect the ESP32 PLC: Ensure that the microUSB cable is properly connected to both 

the ESP32's microUSB port and your computer. 

2.​ Switch to Boot Mode: Move the switch next to the microUSB port to the right side 

(Boot Mode). 

3.​ Upload the Code: Proceed to upload your program to the ESP32 PLC. 

4.​ Switch Back to Programming Mode: After the code has been successfully uploaded, 

move the switch back to the left side (Programming Mode). 

5.​ Reset the ESP32 PLC: Press the RESET button located on the top of the ESP32 PLC 

board. 

This should resolve most issues with uploading programs to your ESP32 and allow you to use 

the serial monitor as intended. 
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16​ Instructions for troubleshooting 

Programming with Linux hardly gives any problem but, with Windows or Macintosh can appear 

some issues related to firmware compatibility with the Operating System. So, if you have any 

problem with Windows or Macintosh, like the system not recognizing the device or a timeout 

when uploading the code, it is recommended to install the following drivers and restart the 

computer to avoid any related issue. Be careful installing them: you must select the right 

version for your OS, CPU architecture and the USB type port that you are using (2.0/3.0).  

16.1​CP210x Driver (for USB 2.0/3.0) 

https://www.silabs.com/developers/usb-to-uart-bridge-vcp-drivers 

16.2​D2XX Driver (for USB 2.0) 

https://ftdichip.com/drivers/d2xx-drivers/ 

16.3​D3XX Driver (for USB 3.0) 

https://ftdichip.com/drivers/d3xx-drivers/  
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17​ Instructions for interconnection between Industrial 

Shields controllers  

 

17.1​RS-232 Communication: 

 

17.2​RS-485 Communication 

17.2.1​ Half Duplex  
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17.3​Ethernet 

 

For Ethernet communication between two Industrial Shields equipment an SFTP CAT-6 

Ethernet crossover cable must be used. 

 

18​ Digital inputs threshold detection 

The Ardbox inputs have a minimum voltage threshold to reliably detect the signal when used 

as digital input. The threshold values are: 
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19​ Typical Connections 
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20​ Connector details 

The connector inside the PLCs that mounts on the PCB is  MC 0,5/10-G-2,5 THT – 1963502 from 

Phoenix contact. MC0,5/10-G-2,5THT  

For I/O and power supply there is a FK-MC 0,5/10-ST-2,5 - 1881406 connector from Phoenix 

contact. FK-MC 0,5/10-ST-2,5 

 

Connection details: 

Article reference MC 0,5/10-G-2,5 

THT 

Height 8,1mm 

Pitch 2,5mm 

Dimension 22,5mm 

Pin dimensions 0,8x0,8mm 

Pin spacing 2,50mm 
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Article reference FK-MC 0,5/10-ST-2,5 

Rigid conduit section min. 0,14 mm² 

Rigid conduit section max. 0,5 mm² 

Flexible conduit section min. 0,14 mm² 

Flexible conduit section max. 0,5 mm² 

Conduit section AWG/kcmil min. 26 

Conduit section AWG/kcmil max. 20 
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21​ Mechanical Characteristics 

●​ Dimension ESP32 ETHERNET & WIFI & BLUETOOTH PLC: 

 

 

 

 

 

 

 
 
 

●​ DIN Rail mounting 
 
 
 
 
 
 
 
​  
 
 
 
 
 
 
 
 
 
 
​  
 
 
 
 
 
For optimal operation of the product, it must be located in an electrical cabinet with IK08 

mechanical protection. The minimum IP protection degree required is IP56. 
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22​ Installation and Maintenance 

 
Notes for installation: 
 

●​ The installation position should be free from the following: dust or oil smoke, 
conductive dust, corrosive or flammable gas, high temperature, condensation, and 
rain.  

●​ Besides, vibration and impact also affect the PLC normal operation and shorten its 
lifespan; electric shock, fire or misact also damages the product. During drilling or 
wiring, prevent the metal particles or wire segments from falling into the PLC casing, 
which may cause fire, fault or misact.  

●​ After the PLC installation, clean the ventilation duct to prevent blocking, which may 
cause bad ventilation, or even fire, faults or misact.  

●​ Do not online connect, plug or unplug cables, which are apt to cause electric shock or 
damage the circuit. Installation and wire connection must be firm and reliable. Poor 
connection could cause a misact.  

●​ Use shielded twisted pairs for the I/O of high frequency signal and analog signal to 
improve system IMS. 

 
The installation environment should be free from dust, oil smoke, conductive particles, 
corrosive or flammable gases, high temperature, condensation, and rain.  
 
Besides, vibration and impact also affect the PLC normal operation and shorten its lifespan. It is 
recommended to install the PLC, together with the matching switches and contactors, in a 
dedicated electric cabinet and keep the cabinet ventilated. If the location has high ambient 
temperature or heat generating equipment nearby, install forced convection devices on top or 
sides of the cabinet to avoid over-temperature. During drilling or wiring, prevent the metal 
particles or wire segments from falling into the PLC casing, which may cause fire, fault or 
misact. After the PLC installation, clean the ventilation duct to prevent blocking, which may 
cause bad ventilation, or even fire, faults or misact. 
 
The only way to disconnect the equipment from the electrical network is by removing the 
connectors that feed the equipment. Once installed in the electrical cabinet it is very important 
to ensure the power connectors for proper operation. 

 
 

Separate the ESP32 ETHERNET & WIFI & BLUETOOTH PLC from heat, high voltage and electrical 
noise: 

 
 

Always separate the devices that generate high voltage and high electrical noise from the 
ESP32 ETHERNET & WIFI & BLUETOOTH PLC. When configuring the layout of the ESP32 
ETHERNET & WIFI & BLUETOOTH PLC inside your panel, consider the heat-generating devices 
and locate the electronic-type devices in the cooler areas of your cabinet. Reducing the 
exposure to a high-temperature environment will extend the operating life of any electronic 
device. Consider also the routing of the wiring for the devices in the electric cabinet. Avoid 
placing low-voltage signal wires and communications cables in the same tray with AC power 
wiring and high energy, rapidly-switched DC wiring.  
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Provide adequate clearance for cooling and wiring ESP32 ETHERNET & WIFI & BLUETOOTH PLC. 
It is designed for natural convection cooling. For proper cooling, you must provide a clearance 
of at least 25cm above and below the devices. Also, allow at least 25cm of depth between the 
front of the modules and the inside of the enclosure. 

 
Notes for maintenance: 
 
A well-planned and executed maintenance program is essential to the satisfactory operation of 
solid-state electrical equipment. The kind and frequency of the maintenance operation will 
vary with the kind and complexity of the equipment as well as with the nature of the operating 
conditions. Maintenance recommendations of the manufacturer or appropriate product 
standards should be followed. 
 
The following factors should be considered when formulating a maintenance program:  
 

●​ Maintenance must be performed by qualified personnel familiar with the construction, 
operation, and hazards involved with the control.  

●​ Maintenance should be performed with the control out of operation and disconnected 
from all sources of power.  

●​ Care should be taken when servicing electrostatic sensitive components. The 
manufacturer's recommendations for these components should be followed.  

●​ Ventilation passages should be kept open. If the equipment depends upon auxiliary 
cooling, e.g., air, water, or oil, periodic inspection (with filter replacement when 
necessary) should be made of these systems.  

●​ The means employed for grounding or insulating the equipment from ground should 
be checked to assure its integrity. 

●​ Accumulations of dust and dirt on all parts, including on semiconductor heat sinks, 
should be removed according to the manufacturer's instructions, if provided; 
otherwise, the manufacturer should be consulted. Care must be taken to avoid 
damaging any delicate components and to avoid displacing dust, dirt, or debris in a way 
that permits it to enter or settle into parts of the control equipment. 

●​ Enclosures should be inspected for evidence of deterioration. Accumulated dust and 
dirt should be removed from the top of the enclosures before opening doors or 
removing covers.  

●​ Certain hazardous materials removed as part of maintenance or repair procedure (e.g., 
polychlorinated biphenyls (PCBs) found in some liquid filled capacitors) must be 
disposed of as described in Federal regulations. 

 
Safety rules for maintenance personnel 
 
Consider the following steps to follow. A false manoeuvre could be the cause of an accident or 
material damage. 
Do not disassemble or modify the modules. This could lead to breakdowns or malfunctions and 
could lead to injuries or fire. 
 

●​ All types of radio communication devices, including mobile phones and personal 
handy-phone systems (PHS), must be kept more than 25cm away from the PLC in all 
directions. Failure to observe this precaution exposes malfunctions caused by excess 
temperature. 

●​ Disconnect the external power supply of the system (on all phases) before connecting 
or disconnecting a module. Failure to observe this precaution may cause faults or 
malfunctions of the module. 
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●​ Tighten the screws of the terminal ports and the screws of the connectors within the 
prescribed tightening torque. Insufficient tightening can lead to loose parts or wires 
and cause malfunctions. Excessive tightening can damage the screws and / or the 
module, with the risk of falling, short circuits and malfunctions. 

●​ Before handling a module, dispose of the electrostatic charge accumulated by the 
human body by touching a suitable conductive object. Failure to observe this 
precaution may cause faults or malfunctions of the module. 

 
Repair note: 
 
If the equipment is suitable to be repaired, it must be verified that the equipment remains in a 
safe state after repair.  
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23​ Revision Table 

 

Revision Number Date Changes 

0 01/03/2021 First implementation 

1 13/04/2021 Changes on the section 11 

2 27/09/2021 Section 15 added 

3 19/11/2021 New version changes added 

4 26/01/2022 Section 2.3 added 

5 22/06/2022 Changes on sections 12 and 15 

6 21/07/2022 Changes on sections 1.7 and 2.2 

7 08/09/2022 Changes on section 10.1 

8 14/10/2022 Section 9 added 

9 07/11/2022 Section 11.9 added 

10 14/04/2023 Section 10 modified 

11 10/07/2023 Errata Correction 

12 25/08/2023 Sections 7 and 8 modified 

13 06/03/2024 Added sections 12.1.2 and 12.1.3 

14 11/03/2024 Added section 17 

15 29/04/2024 Added section 12.1.4 

16 19/08/2024 Section 12 modified  

17 04/09/2024 Added section 15 (“How to upload a program”) 

18 26/09/2024 Added section 3.4 (“Isolation Precautions”) 

19 22/10/2024 Revised PLC nomenclature 

20 09/01/2025 
Added sections 10.2 (Serial1) and 10.3 (Serial2), 

added recommended microSD on section 11.8, and 
corrections on section 2.1 (“General Specifications”) 

 

64 
 



​ ​ Rev. 20: 09-01-2025 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
About Industrial Shields: 
 
Direction: Camí del Grau, 25 

Zip/Postal Code: 08272  

City: Sant Fruitós de Bages (Barcelona)  

Country: Spain 

Telephone: (+34) 938 760 191 / (+34) 635 693 611 

Mail: support@industrialshields.com  
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